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1 Introduction

Thank you!

Congratulations on your purchase of Pyramix Virtual Studio. More than just a product, this is a gateway to the
future of sound recording, editing, mixing and mastering. You have joined a worldwide community of users who
have already discovered the Pyramix advantage.

Note: IMPORTANT! - The first thing you need to do is register your software to acquire
your Pyramix key(s) and to be included in our user support list.

https://my.merging.com/auth/register

Please also subscribe to the User Forum at:

http://forum.merging.com

Scope

Pyramix Virtual Studio is a powerful and flexible Digital Audio Workstation (DAW) integrating hard disk recording
and editing, digital audio mixing, effects processing, metering, machine control, video and mastering. Complete
turnkey systems are available.

This document is intended to get you up and running with Pyramix, Pyramix MassCore and Pyramix MassCore
RAVENNA as quickly as possible. For more detailed information about the Horus / Hapi hardware and the Pyramix
software please see their specific Guides.

Important! If you are installing an upgrade to Pyramix please read: For Users Per-
forming Upgrades on page 10 first.

If you have purchased Pyramix Virtual Studio as an integrated (Turnkey) system, the installation information in this
guide will be redundant, since these systems come with all hardware and software pre-installed. If you are config-
uring your own system, please refer to the following instructions.

Windows 10 - IMPORTANT!

Note: Merging strongly recommends you defer feature updates in Windows 10.
Windows 10 users should never update to Beta Windows versions or install major new
updates before making sure they are supported by Merging. Please refer to our Windows
10 Configuration Guide:

https://confluence.merging.com/display/PUBLICDOC/Windows+10+Configuration

Details about the recommended Windows 10 Defer Update setting
https://confluence.merging.com/display/PUBLICDOC/Windows+10+Defer+Updates

Windows 10 Recommended Version for MassCore
Pyramix v12.0 is supported under the following Windows 10 updates:

. Anniversary (1607)

. Creator (1703)

. Fall Creator (1709)

. Spring Creator (1803)

. October Update (1809)
. May 2019 Update (1903)

As well as the Meltdown and Spectre and Zombieload Windows updates.
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Windows Updates
Users wishing to apply Windows updates may refer to the Merging list of validated Compatible Windows updates:

https://confluence.merging.com/pages/viewpage.action?pageld=25755762

Important! Before you perform a Windows 10 update on a system already running a MassCore version it will be
important for users to remove MassCore from the MT Security MassCore tab prior to performing a system
update.

Updating from Windows 7 to Windows 10
Users performing an update from Windows 7 to Windows 10 should proceed in this way:
https://confluence.merging.com/display/PUBLICDOC/Updating+Windows+7+to+Windows+10+Anniversary+1607
Note: Users wanting to update Windows 10 to another version must follow the proce-

dures documented here:
https://confluence.merging.com/display/PUBLICDOC/Windows+Configuration+Guide

Select the appropriate document according to your current Windows 10 version.
Note: Once the update to the required Windows version has been completed follow this
Pyramix v12 and MassCore installation Guide.

For Pyramix v12 Native users

Pyramix Native users may use the Windows 10 Anniversary (1607) update, Creator update (1703), Fall Creator
(1709), Spring Creator (1803), October Update (1809) or May 2019 Update (1903).
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2 Pyramix Versions - Compatibility and Installation Steps

Native (ASIO on 3rd party hardware):

Compatibility: Windows 7 Professional 64-bit and Windows 10 Professional 64-bit
Installation Steps:
. Pyramix Software Installation, See: Pyramix Software Installation on page 18
Entering Authorization Keys, See: Pyramix Software Registration on page 20

. Select ASIO and the correct card/device in the VS3 Control Panel (Start Menu > Control Panel > VS3 Control
Panel) See: Configure ASIO in the VS3 Control Panel on page 32

Native with ASIO for RAVENNA and Horus / Hapi:
Compatibility: Windows 7 Professional 64-bit and Windows 10 Professional 64-bit

Installation Steps:

. Install the Merging RAVENNA ASIO Driver provided with your Horus / Hapi or available from:

https://www.merging.com/support/downloads

. Select ASIO and the correct card/device in the VS3 Control Panel (Start Menu > Control Panel > VS3 Control Panel)
. Optional: Pyramix Software Installation See: Pyramix Software Installation on page 18
. If Pyramix Software is installed: Entering Authorization Keys See: Pyramix Software Registration on page 20

. Select the desired network adapter in Merging RAVENNA ASIO Panel (Start Menu > All Programs > Merging Tech-
nologies > Merging RAVENNA ASIO Driver > Merging RAVENNA ASIO Panel) please see details in the Merging
RAVENNA ASIO and CoreAudio Guide available in Start Menu > All Programs > Merging Technologies > Documen-
tation > Merging RAVENNA ASIO Driver > Merging RAVENNA ASIO Panel

. Select ASIO/RAVENNA in the VS3 Control Panel (Start Menu > Control Panel > VS3 Control Panel) See: Configure
ASIO in the VS3 Control Panel on page 32

Note: Please download and install the latest ANEMAN application in order to manage
and monitor your AolP devices from:

www.aneman.net/#download

Mykerinos only:

Not supported from version 10.x. Last compatible version is
Pyramix v7.1 32-bit installer.

MassCore with Mykerinos:

Not supported from version 10.x. Last compatible version is
Pyramix v9.1 32-bit installer.
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MassCore with RAVENNA and Horus / Hapi:
Compatibility: Windows 7 Professional 64-bit and Windows 10 Professional 64-bit.

Note: Merging strongly recommends users to perform a Windows Update prior to installing Pyramix v12.

Installation Steps:

. NET-MSC-GBEXT1 Installation See: Installing the Merging Technologies NET-MSC-GBEXT PCle Ethernet Controller
Card on page 27

. Pyramix Software Installation, See: Pyramix Software Installation on page 18

. Entering Authorization Keys, See: P Pyramix Software Registration on page 20

. MassCore Installation, See: MassCore Installation on page 22

. Select MassCore with RAVENNA in the VS3 Control Panel (Start Menu > Control Panel > VS3 Control Panel)

Quick Setup Checklist For Systems with Horus / Hapi

1. Shut down the system and install the MassCore NET-MSC-GBEX1 PCle Ethernet controller card. (Card drivers are
included in the Pyramix and Ovation installers.)

Existing users of 64 bit MassCore must uninstall the previous MassCore version from the MT Security application.
MassCore users MUST configure their BIOs settings. Please see: BIOS Settings on page 14

Disable Windows Firewall in Windows Control Panel Security

Install Google Chrome

Install Pyramix v12.x or Ovation v8.x.

Enter your MassCore (RTX64 - 3.0) key in MT Security Settings then import your v12/v8keys in MT Security Settings.

On a fresh install also in MT Security Settings install MassCore from the MassCore Tab.

PPN PR

MassCore SMP users (recommended for i7 CPU configurations and above) should launch the VS3 Control Panel and
assign 2 cores to MassCore. (A reboot will be required.)

10. In the VS3 Control Panel ensure that RAVENNA is selected in the Hardware section.
11. Configure the Switch/Router (if present). Please refer to the RAVENNA Network Guide
12. Launch Pyramix

13. You can also launch the MTDiscovery application and double-click on the Horus / Hapi entry for browser remote
access.

14. Ensure that the Horus / Hapi is set to the same sampling rate as Pyramix or Ovation. A warning prompt will appear if
this is not the case.

15. We recommend Horus and Hapi users update to the latest firmware available. Obtainable here:

https://www.merging.com/products/interfaces/downloads

16. Configure I/O as required in Pyramix/Ovation and Horus /Hapi. Please download and install the latest ANEMAN appli-
cation in order to manage and monitor your AolP devices from:

www.aneman.net/#download
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3 For Users Performing Upgrades

Note: Pyramix v12 keys are required to run Pyramix v12. Users running MassCore will
need a new Mass-Core version (RTX64 - 3.7) that requires the RTX 3.0 key.

Pyramix
We recommend uninstalling any previous version of Pyramix before installing Pyramix v12.
From the Windows Control Panel select Programs and features.

Remove the installed version of Pyramix.

Note: Merging recommends installing v12 BEFORE uninstalling the previous version of
MassCore. UNLESS you are planning to update your Windows 10 version and already
have a MassCore version installed, then you must follow the update procedure in the
documents linked to below. N.B In this case the previous version of MassCore MUST be
uninstalled BEFORE uninstalling the previous version of Pyramix:

https://confluence.merging.com/display/PUBLICDOC/Windows+Configuration+Guide

Note: IntervalZero version should read: IntervalZero RTX64 3.7 version 3.7.0.4983

VCube

Pyramix 12 can coexist with VCube Version 8 (Be aware of recommended configurations.)
Masscore

MassCore users MUST remove the existing MassCore runtime.

Once Pyramix 12 is installed follow these steps:

1. Launch MT Security Settings and select the MassCore Tab.

2. Choose the Uninstall MassCore RunTime option and reboot. (There will be one reboot.)

Note: RTX DONGLE USERS (SSK-HUD-RTX). From RTX64 3.6, the HASP HL driver is
installed automatically together with the RTX64 runtime. Manual driver installation is no
longer required. If you installed this driver manually, please uninstall it now (Windows
Control Panel > Programs & Features > Sentinel Runtime).

Note: If the installation fails refer to the documentation here:

https://confluence.merging.com/pages/viewpage.action?pageld=27852814

3. Reboot selecting the NON-MassCore Windows Boot line. If you experience any problems please refer to the
troubleshooting document here:

https://confluence.merging.com/display/PUBLICDOC/MassCore+Uninstall+Troubleshooting
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4. The previous Masscore RTX64 will now uninstall:
j‘Er' Update 2 for IntervalZerc RTXE4 3.6 Runtime - InstallShield Wi... — )4

Uninstalling Update 2 for IntervalZero RTX&4 3.6 Runtime

The program features you selected are being uninstalled.

Flease wait while the Installshield Wizard uninstalls Update 2 for
IntervalZero RTXE4 3.6 Runtime. This may take several minutes.

Status:

ack Mext = Cancel

IntervalZero Uninstall dialog

5. Once the uninstallation is finished, there is no need to reboot. Launch MT Security Settings and enter your
v12 keys (including the new RTX64- 3.0 MassCore key) or confirm their presence.

Warning! If when entering your new MassCore key you experience a failure message,
please contact:

keys@merging.com

and let us know your Dongle serial number so that Merging can identify your current MassCore/RTX64 key and
renew it if necessary.

Note: Users installing MassCore may see a popup dialog un-authorized license message.
Please ignore until reboot.

RTX64 validation is not available.
X64 licens lon is n

RTX64 validation is not available dialog
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6. Select the MassCore Tab and choose the Install MassCore RunTime option.

Keys  MTActivekey MassCore  Apout

» MassCore Unlimited
-

@ MassCore RunTime not installed on this computer; Please install it.

Install MassCore RunTime

Activation

Seral Numbd IntervalZero RTXEd 3.7 Runtime

RTX64 Key| [E I[d| Please wait while Windows configures IntervalZero RTXE4 3.7 |

; Rurtime

Time remaining: 23 seconds

QK Cancel

MT Security Settings - MassCore tab

7. An RTX64 Driver approval dialog may appear. Accept it, click on OK to close the MT Security Settings panel
and reboot the system.

Note: Please note that the installation process can take some time.

After installation you should see an Interval Zero entry in Windows Control Panel > All Control Panel Items
> Programs and Features. This should read: Interval Zero RTX64 3.7 Runtime (Version 3.7.0.4983).

9. Launch the VS3 Control Panel and configure it for MassCore - RAVENNA See: Configure RAVENNA in the
VS3 Control Panel on page 29

Installation Guide v12.0.5 Hotfix : For Users Performing Upgrades

AMERGING %

AUDIO FOR THE NETWORKING AGE



Pyramix

DIGITAL AUDIO WORKSTATION

4 System Requirements

Wintel platforms tend to increase in number of cores, speed and performance at a tremendous rate. New and
faster processors are released almost on a monthly basis. Therefore we have not included suggested Motherboard
or Processor specifications here.

We maintain a list of up to date PC configurations in the Support Section of our website at:
http://www.merging.com/pages/pcconfig

WARNING: Pyramix v12 is supported on 4th Generation Intel Core Processors (4XXX and
higher) and will not launch on previous generation Processors.

Please refer to our system recommendation for more details:
https://confluence.merging.com/pages/viewpage.action?pageld=24608853

Other Components

. Graphics Card: As of Pyramix 12, Ovation 8 and VCube 8, Merging strongly recommends using a dedi-
cated graphic card rather than onboard graphics. Most particularly when the following are required

. Multiple display outputs,

. OpenGL Ul plugins (Flux, Izotope, ....)

«  Working with video, or when your workflow places high demands on graphics.
Please refer to the Pyramix PC Specifications for all details:

http://www.merging.com/pages/pcconfig

https://confluence.merging.com/display/PUBLICDOC/Graphic+cards+recommendations

. Sufficient HD space and speed for your audio media files. The speed and amount of disk space required
depends on sample rate, word length, number of tracks and length of program material.

. A typical 7200 RPM SATA drive is sufficient for 48 tracks at 48 kHz. Higher track-counts and/or higher sam-
pling rates will require an SSD drive and/or multiple drives configured in Raid 0, 1, 10 or 5

. We recommend disks should be formatted as NTFS volumes with 64kB block sectors for audio. For video
128kB block sectors are desirable.

. BD/DVD/CD-ROM combo drive or better.

. Multiple 19” or larger monitors highly recommended.

Minimum resolution 1280x1024

. 3 button mouse

Pyramix MassCore Systems

Certified Operating Systems

. 0S: We recommend and certify Pyramix Version 12.x and later under Windows 7 Professional 64-bit
and Windows 10 Professional 64-bit.

Pyramix Native

Certified Operating Systems

. 0S: We recommend and certify Pyramix Version 12.x under Windows 7 Professional 64-bit and
Windows 10 Professional 64-bit.
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5 PC Setup

Motherboard Drivers and Utilities

Motherboard drivers should be updated to current versions.
Motherboard Utilities should NOT be installed.
Please refer to our Windows configurations guide for more details:

https://confluence.merging.com/display/PUBLICDOC/Windows+Configuration+Guide

BIOS Settings

Recommended BIOS Settings
Boot Device Control

We recommend that the UEFI boot should be disabled and set to:
Boot Device Control: Legacy only

Hyperthreading

Intel® Hyperthreading Technology is supported on 64 bit MassCore systems. This setting is commonly found in
Main Bios page, or under CPU configuration. (see the motherboard manual for further details).

. MassCore SMP users: Merging Recommends that Hyperthreading is enabled to benefit fully from the real-
time engine power, VS3 support and the MassCore multithreaded engine.

. MassCore Non-SMP users: Will gain some of these benefits by not enabling Hyperthreading, so that a full
single Core is dedicated to MassCore

. For further information refer to the Pyramix User Manual chapter MassCore & VST Core Allocation.

. Pyramix Native: We recommend that Hyperthreading is enabled.

Other Settings

The following features can create MassCore overloads (blinking red MSC).

Intel® Speedstep Technology (also known as Enhanced Intel® SpeedStep), as well as CPU C State (or Intel® C-State)
features must be disabled in the BIOS.

Some Recent Intel boards have a global setting to disable those features known as Intel® Dynamic Power Technol-
ogy. If present this should be turned off. These settings are commonly found in BIOS Power options or CPU Con-
figuration.

Overclocking is not supported.

Configuration Guides
Windows 10 users should refer to the Merging Windows 10 Configuration Guide:

https://confluence.merging.com/display/PUBLICDOC/Windows+10+Configuration

Merging has a number of specific PC-configuration guides which are available on request. Tell us your system con-
figuration modeled on our recommendations at:

http://www.merging.com/support/pc-config

so that we can send you the latest configuration guide. Please contact:

support@merging.com
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Display Settings

Pyramix requires a minimum display resolution of 1280x1024 in 256 colors which MUST be set to small fonts
mode.
A Merging Windows configuration guide is available with recommendations here:

https://confluence.merging.com/display/PUBLICDOC/Windows+Configuration+Guide

Windows Control Panel > System > Advanced System Settings opens the System Properties window. Select
the Advanced tab > Performance Settings to open the Performance Options window. Choose the Visual

Effects Tab:
Windows 7

Onboard Graphics (Intel) Dedicated Graphic Card
@ Custom; @ Custom:!

v | Animate controls and elements inside windows ¥ | Amemate controls and elements inside windows
Animate windows when minimizing and maximizing Aremate windows when minimizing and masdimizing
Animations in the taskbar and Start Menu Animations in the taskbar and Start Menu
Enable Asro Peek Enable Aero Pesk
Enable desktop composition | Enable desktop composition
Enable transparent glass Enable transparent glass
Fade or shde menus into view Fade or slide menus inbo view
Fade or shde ToolTips into view Fade or slide ToolTips into view

| Fade out menu items after dicking | Fade out menu items after dicking
Save taskbar thumbnail previews Save taskbar thumbnai previews

| Show shadows under mouse pointer | Show shadows under mouse pointer

v | Show shadows under windows | Show shadows under windows
Show thumbnails instead of ions Show thumbnails instead of icons
Show translucent selection rectangle Show ranslucent selection rectangle
Show window contents while dragging Show window contents while dragging
Slide open combo boxes Slide open combo boxes

v | Smooth edges of screen fonts | Smooth edges of screen fonits

v | Smooth-scroll list boxes ¥ | Smoath-scroll kst boxes

| Use drop shadows for icon labels on the desktop | Use drop shadows for icon labels on the desktop

| Lise visual styles on windows and buttons | Uise visual styles on windows and buttons

Windows 10

=
(% Custom:

[+] Anirmate controls and elements inside windows
[] Animate windows when minimizing and maximizing
[] Animations in the taskbar

[] Enable Peek

|:| Fade or slide menus into view

[] Fade or shide ToolTips into view

Fade out menu items after clicking

[ Save taskbar thumbnail previews

Show shadows under mouse pointer

[+ Show shadews under windows

[] Show thumbnails instead of icons

] Show translucent selection rectangle

[ show windew contents while dragging

0

[+] Smooth edges of screen fonts

[#] Smooth-scroll ist boxes

Use drop shadows for icon labels on the desktop
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Disable the following settings by unticking the boxes to prevent MassCore peaks:

. Animate Windows when minimizing and maximizing - disable
. Animations in the taskbar and Start Menu - disable
. Aero Peek - disable
. Enable desktop composition - disable (Windows 7 Only)
. Enable transparent glass - disable
. Fade or slide menus into view - disable
. Fade or slide ToolTips into view - disable
. Save taskbar thumbnail previews - disable
. Show translucent selection rectangle - disable
. Show window content while dragging - disable
. Slide open Combo boxes - disable
Power Management

N.B. As with other Digital Audio Workstations and Non-Linear Editors, we recommend setting the PC to the High
Performance Power management scheme or RTX64-Recommended (MassCore Users).

MassCore is NOT designed to support Standby modes.

Aero graphics

Disable AERO themes for maximum performance. (Windows 7 Only)

Indexing

In the interests of better performance we recommend turning Indexing OFF for all Data drives in the system.

Other Applications

Like all Digital Audio Workstations, Pyramix works best when there are no other unnecessary applications or ser-
vices running.
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Video in Timeline / PyraCube

As of Pyramix 12, Ovation 8 and VCube 8, Merging strongly recommends using a dedicated graphic card rather
than onboard graphics.

In a Pyramix Native system video performance depends principally on the system configuration. Laptop users
must set the Windows Power Scheme to High Performance.

Please refer to our list of recommended configurations for more details:
http://www.merging.com/support/pc-config
And our Configuration Guide:

https://confluence.merging.com/display/PUBLICDOC/Windows+Configuration+Guide

Video Hardware
AJA Video cards are not supported on Windows 10.

Merging supports Blackmagic design Video Cards thru the DeckLink SDK. This covers: DeckLink, UltraStudio and
Intensity product lines. Decklink Studio 4K, Decklink 4K Extreme and Decklink 4K Pro have been validated.

Note: The Decklink 8K Extreme Pro is not supported above 4K DCI / 25 fps

The DeckLink Studio monitor is known to be working but has no Video reference to ensure genlock. The recom-
mended Blackmagic Design installer version is 10.3.7 and above, the latest version certified is 10.11.4. Please
download and install from:

https://www.blackmagicdesign.com/support

ADR/Ovation Keyboards

Note: ADR/Ovation keyboard users must update the keyboard driver if running on Win-
dows 10 October update (1809)or above. Please refer to the following page for installa-
tion information:

https://confluence.merging.com/display/PUBLICDOC/Pyramix+ADR+and+Ovation+keyboard-+install+guide
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6 Pyramix Software Installation

Important! If you have not already done so, before installing the Merging Technologies
software for the first time OR as an update please run Windows Update and accept any
updates marked as Important. Note that this can take a considerable time. (Over an
hour in some cases.) This is a Microsoft problem.

Note: You must have full Administrator Access to install Pyramix.

Installation Overview:

Note: If you have purchased hardware options such as the NET-MSC-GBEX1 PCle Ether-
net card, the Sync Board and or a Blackmagic video card, please install these following
the instructions in the accompanying documentation. The drivers for all of these except
Blackmagic cards, ADR Keyboard and Sealevel GPIOs are installed automatically with
the Pyramix software.

Note: The Sealevel GPIO's are no longer installed with the Pyramix software. Please refer
to the page here for installations:

https://confluence.merging.com/pages/viewpage.action?pageld=15139174

Note: Where applicable Blackmagic video card drivers have to be downloaded from the
Blackmagic website and installed separately. The recommended Blackmagic Design
installer version is 10.3.7 and above, the latest version certified is 10.11.4 Please down-
load and install from:

https://www.blackmagicdesign.com/support

Installer

The Pyramix software uses an automated installer wizard which will install all necessary prerequisites. Installing
Ovation will also install Pyramix.

Note: The security dongle must be in place and the security keys entered before
attempting to launch the software.

Flux VS3/V3 plug-ins

Download the Flux Center application in order to install the Flux VS3 plugins:

https://www.fluxhome.com/download

More details here:

https://confluence.merging.com/display/PUBLICDOC/Flux+Download+Center
Ensure you have valid Merging Flux v3 Keys in order to run these Flux VS3 plug-ins.

VB V53 plug-ins

VB VS3 plug-ins are installed by default with a complete Pyramix install.
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Standalone Album Publishing application:

The new Standalone Album Publishing application is included as of Pyramix v11.1 and allows several instances to

be runconcurrently.

Independent Settings may be applied for each instance. (Via initial Settings changes.)

7 Running the Installer

Note: If you have a SafeNet dongle please remove this before installing Pyramix and
replace it after installation is complete.

Note: The HASP dongle is not supported on 64-bit systems. If you have a HASP dongle
please contact your Merging Technologies Sales Partner to purchase a SafeNet dongle
and transfer your keys.

Once the NET-MSC-GBEX1 Ethernet card has been properly installed, you can now install the Pyramix 11.x soft-
ware.

To install the Pyramix Virtual Studio v12.x software insert the USB memory stick. The installation program will
auto-start on a PC where auto-start is configured on. Otherwise, double-click on the USB memory stick icon.

Please follow the automatic installation procedure accepting the option to install unsigned drivers and re-boot
your PC once setup is complete.

Note: For Windows 7 Users Only: The installer checks and verifies if the Windows 7
updates KB3033929 and KB3123479 are present on the system and if not installed
already (from running Windows Update manually or automatically) they will be installed
for Windows 7. If the updates are required, please be patient. The update can take as
long as one hour. This delay is caused by Microsoft. An extra re-boot is required once the
updates are installed.

N.B. If the Windows Update Service is disabled, Windows cannot install any updates,
one consequence will be that the MassCore NIC will not work. To check if the Service is
running open the Windows Control Panel, go to Administrative Tools > Services and
ensure that the Windows Update service is started and therefore running. If the Service
is stopped it can be started manually by selecting it and choosing Start in the Action
menu or from the right-click context menu.

Note: This update is already embedded in Windows 10.

Note: For Windows 7 Users: If the installation appears to freeze for a long period please
check that the Driver Signing warning dialogue is not hidden behind another Window.
Installation will not continue until you click OK in this dialog.

WARNING: Certain computers do not properly shut down despite the reboot command issued by the installer but
only perform a log off. In this case, please activate a full shut down manually.
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8 Pyramix Software Registration

The Pyramix Virtual Studio software and its various software options are protected by an authorization key
mechanism which uses a unique registration key number generated by Merging Technologies. Based on pur-
chased software components, this key is unique to your security dongle, your Company Name and your User
name. Once you have registered your software you will be provided with this Key or Keys (depending on the cho-
sen options).

If you did not receive this key, have lost it or would like to change the user and/or company name, please contact
your Merging Sales Partner with your SafeNet dongle serial #, your User Name, your Company Name and the list of
purchased software components. Usually, a key can be issued within one business day, after the verification of
your personal data has been completed.

Entering your Key(s)

After the Pyramix installation process you will be prompted to enter your Authorization Key. If you click Yes the
MT Security Settings dialog will be launched automatically, allowing the Key or Keys to be entered immediately.
If you choose not to enter your Key at this point you can do so later by choosing one of the following procedures:

1. Double-click the file YourPersonalKeyXXXXX.mtk. This is attached to the email containing your Key(s).

2. Open the MT Security Settings Control Panel
(Windows Task Bar Start > Control Panel > MT Security Settings),
click the Import Key button and browse for your Key file named:

YourPersonalKeyXXXXX.mtk

3. Open the MT Security Settings Control Panel (as above), in the Registration section select the dongle num-
ber corresponding to the SafeNet Key, click the Enter Key button and type your User Name, Company Name
and Key then click OK. Repeat this step for each Keys listed in the email.

Changing or re-entering a Key
Should you need to subsequently change or re-enter a Key, follow the appropriate option above.

Evaluation Mode
If started without a valid registration key, the software will recognize that no valid key is available and will start in
“evaluation” mode, which only allows for basic operation of the software as follows:

. Limited to 2 channels of I/0 on host soundcard
. No Project > Save function

. Tone is added to new recordings

. All optional extra cost features are deactivated

All editing functions, playback, file type conversions etc. are fully functional.
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Keys
At any time you can check the serial number of your Security dongle and check the software options enabled in
your system in the MTSecurity application.

Keys | MTActivektey | MassCore | About

Registration
Safehiet Key -
¥
o | Inchude Keys stored on SafaMNet Dongles in MT Secuity
Sadial Mumber 500000000
User Name  RecandoRyan

Comparry Hame  Merging Technclogies
Heys
|__Impod Kevls) | | Opbons Valdty 5
Pyramice Coem 01 Dee 2015 l
Erder ey High Sampling Frequancy 01 Dez: 2015 3
Summound Mesng 1 Dee 2015
TimaCoda Supped 01 Dee 2015
Ramowe All Keys Machine Contral Suppon 01 Dec 2015
1| IrtseChangs - Frsl Cut Pro XML 01 D 2015
Famate Cortral Suppoe 01 Dee 2015
.| Pyramix Native Audio Enabled 1 Dee 2015
Update Liser Extendad Natroa Audio Suppar 01 Daz 2015
Mative Audio Suppond 01 Dec 2015
Limtad Mative fasdio Suppart
Vitual Transpadt Sarver 01 Dee 2015
CI-R Support 01 Dee 2015
DOP Suppod 01 Dec 2015
SACD/DSD Support 01 Dec 2015
Cue Sagusncsr
Advanced \hdaa Suppod 01 Dec 2015
Chuick Times Vidlao Player 01 Dec 2015
Cue Shest Prrter 01 Dec 2015 =
i ;

MT Security Settings - Keys tab
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9 MassCore Installation

@ MassCore
System Requirements

A quad core Intel processor is the minimum requirement.
Conditions
. You MUST be logged in as an Administrator to install MassCore

Note: You do not need to be logged in as an Administrator to RUN Pyramix with Mass-
Core™, just to install it.

. You must have a NET-MSC-GBEX1-Ethernet card in your system.

. You must have a MassCore 48 (Base) Key in order to proceed with the installation. You must also have a
MassCore 64bit (Base) key and an RTX 64 key. Please contact your Merging Technologies Sales Partner if
you do not have these options but want to use MassCore.

MassCore Installation

1. Install v12 Pyramix.exe and ensure you have a valid MassCore RTX64 key.

2. Launch MT Security Settings and select the MassCore Tab.

3. Choose the Uninstall MassCore RunTime option and reboot. (There will be one reboot.)

Note: It will only be possible to uninstall MassCore if you boot from the MassCore line.

Note: RTX DONGLE USERS (SSK-HUD-RTX). From RTX64 3.6, the HASP HL driver is
installed automatically together with the RTX64 runtime. Manual driver installation is no
longer required. If you installed this driver manually, please uninstall it now (Windows
Control Panel > Programs & Features > Sentinel Runtime).

Note: If the installation fails refer to the documentation here:

https://confluence.merging.com/pages/viewpage.action?pageld=27852814

4. Reboot selecting the NON-MassCore Windows Boot line. If you experience any problems please refer to the
troubleshooting document here:

https://confluence.merging.com/display/PUBLICDOC/MassCore+Uninstall+Troubleshooting
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5. The previous Masscore RTX64 will now uninstall:
j‘Er' Update 2 for IntervalZerc RTXE4 3.6 Runtime - InstallShield Wi... — )4

Uninstalling Update 2 for IntervalZero RTX&4 3.6 Runtime

The program feature ted are being uninstalled.

Flease wait while the Installshield Wizard uninstalls Update 2 for
IntervalZero RTXE4 3.6 Runtime. This may take several minutes.

Status:

< Back '_5.:'_ = Cancel

IntervalZero Uninstall dialog

6. Once the uninstallation is finished, there is no need to reboot. Launch MT Security Settings and enter your
v12 keys (including the new RTX64- 3.0 MassCore key) or confirm their presence.

Warning! If when entering your new MassCore key you experience a failure message,
please contact:

keys@merging.com

and let us know your Dongle serial number so that Merging can identify your current MassCore/RTX64 key and
renew it if necessary.

Note: Users installing MassCore may see a popup dialog un-authorized license message.
Please ignore until reboot.

RTX64 validation is not available.
ralidation is not

RTX64 validation is not available dialog
7. Enter Your Key(s) in the MT Security Panel (Make sure you have a valid MassCore key.) The MassCore 64bit
and RTX64 keys are required for 64-bit systems.)

8. Forautomatic RTX licence validation on 64-bit systems ensure the system is connected to the Internet during
the MassCore installation. RTX Dongle users must have the dongle plugged in during the installation.

9. Inthe MT Security Panel select the MassCore Tab.
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10. Press the Install MassCore Run Time button (will only be enabled if the MassCore base, MassCore 64bit
keys and a valid RTX64 license code are present.).

Please note that the installation process can take some time to proceed.

- B, B
+# Merging Technologies Security Settings lth

Keys | MTActivekey | MassCore | About

'/.})j MassCore Unlimited

@ MassCore RunTime not installed on this computer; Please install it.

[ Install MassCore FunTime

VS3 merging Technologies Security Settings dialog

11. A Windows Security RTX Driver approval dialog will appear:

.

| Windows Security @
Would you like to install this device software?

Mame: IntervalZero, Inc. RTX64 Drivers
Publisher: IntervalZero, Inc.

Always trust software from "IntervalZero, Inc.”. Install | . Don'tlnstall }

& You should only install driver software from publishers you trust. How can I decide
which device software is safe to install?

Windows Security dialog

12. Click Install. The installation progress window will appear:

IntervalZero RTXE4 3.7 Runtime

_i|Z| Please wait while Windows configures IntervalZero RTXG4 3.7
) -
s Runtime

Time remaining: 23 seconds

RTX64 Install Progress dialog
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13. When the install completes, click on OK in the Merging Technologies Security Settings dialog to close it.
14. Restart System after the install.

Note: Please note that the installation process can take some time. After installation you
should see an Interval Zero entry in Windows Control Panel > All Control Panel Items
> Programs and Features.This should read: IntervalZero RTX64 3.7 Runtime (Version
3.7.0.4983).

15. Launch the VS3 Control Panel:

Merging Technologies Virtual Studio Seﬁingl [i_E-J

/'E Application | Pyramix Virtual Studio A |

Platform |MassCore |

Cores Allocation [zhared by all applications- requires admin rights]

Windows 4 D 4 MazzCore [Dedicated]

Latency

@ Low latency [5.33ms (22 48, 96, 192, 384kKHz)
AESET [4ms (3 48, 96, 192, 384KHz]
Eutra low latency [2.66ms (= 48, 96, 192, 334K Hz]

Ilkra low latency [1.33ms (= 43, 96, 192, 384kHz)

Hardware
On Buz Wideo/TC Monitor Jack

J—% M| @

Ravenna

Audio Bridge
Dizable Mumber of Channels [1/0]; | 16

@ ASI0 Device Mode [to create a wirtual ASI0 Device in the system)

Secondary Audio Device Host Mode
[to connect to an existing Audio Device in the system az a secondary [/0]

Fiewire Mixer Mode [to create a Bewire Miser in the system)

K. | [ Apply ] | Cancel

VS3 Merging Technologies Virtual Studios Settings dialog

16. In the Platform section select MassCore

17. We recommend the use of Low latency or AES67 modes by default. Ultra low latency & Extra low latency
are available for Horus / Hapi users with Pyramix v12.x recommended configurations.

http://www.merging.com/pages/pcconfig

We also recommend that users working in DXD and DSD use Low Latency.
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64 Bit MassCore Notes
. Double licence protection, both MassCore 64bit and RTX64 keys are required BEFORE MassCore installa-
tion. The MassCore 64 bit installation can be performed only if these two keys are present.
. The RTX64 Activation key licence is authorized automatically via an internet connection if present.
. Note that the RTX64 MassCore licence can only be installed ONCE per Windows installation, since it is

locked to the system.

. At present if there is a requirement use MassCore Pyramix on two different computers regularly, it will be
necessary to purchase a second MassCore 64bit Base key. Note that a solution exists for those who would
like to have their MassCore/RTX64bit keys stored on a dongle (Hasp/IntervalZero), instead of having them
linked to a unique system. This allows users to move their MassCore/RTX64 licensing to different systems
by carrying two dongles (Merging-SafeNet & IntervalZero-HASP). This solution requires the purchase of an
additional dongle. Please contact your local Merging Technologies sales office if you require this option.
(Reference: SSK-HUD-RTX).

Re-licencing MassCore 64 bit RTX

If a systems needs to be re-licenced for example after a Windows OS re-installation process or if it is necessary to
move the licence to another system, then you should contact us at:

keys@merging.com

Please give the reason for your system migration or re-installation since the RTX64 key is not meant to be renewed
frequently.

If Merging cannot follow up with a timely response (in emergency or at weekends) please contact the Interval
Zero (RTX) sales team.

Please ensure that you have the RTX64 Authorization Key number (IZRTX64-030-XXXX-XXXX...) when doing so.
Interval Zero Support team:

sales@intervalzero.com
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Certified Operating Systems (OS) for RAVENNA

Pyramix Version 12.x MassCore in RAVENNA mode is certified under Windows 7 Professional (64-bit versions) and
Windows 10 Professional (64-bit versions).

System Requirements
We maintain a list of up to date PC configurations in the Support Section of our website at:

http://www.merging.com/pages/pcconfig
Please refer to the MassCore-RAVENNA recommendations (Quad-Core is the minimum requirement)

Required Hardware
The Merging Technologies NET-MSC-GBEX1 PCle Ethernet controller card is required for MassCore - RAVENNA.

Installing the Merging Technologies NET-MSC-GBEX1 PCle Ethernet Controller Card
The NET-MSC-GBEX1 PCle card should be installed in your computer before installing Pyramix v12.x

The NET-MSC-GB EX1 card

Procedure

1. Power down your PC and switch it off at the wall. Remove the screws securing the top or side of the case and
carefully slide off the panel.

2. Ananti-static wristband is sensible precaution whenever working with sensitive electrical equipment. Keep-
ing one hand on a metal part of the case will have the same effect, though you may need both hands when
installing certain items of hardware.

3. Locate an empty PCle slot and remove the metal backing plate by removing the screw holding it in place and
carefully sliding it up and out. In some cases, there are no backing plates and you will need to remove a length
of metal instead. Do this using a flat-blade screwdriver and/or pliers, taking care to avoid any sharp edges left
behind.

Installation Guide v12.0.5 Hotfix : MassCore - RAVENNA

AMERGING %

AUDIO FOR THE NETWORKING AGE


http://www.merging.com/pages/pcconfig

Pyramix

DIGITAL AUDIO WORKSTATION

4. Remove the NET-MSC-GBEX1 card from its protective anti-static envelope and align it with the vacant PCle
slot as shown below.

= Anti-Sy rge
[ T TRy

— Lo
B oours
218uIs - 8000830 NS

i |
I||| FXIED N LI EINIL'II:I..‘].LI‘L‘I"

Installing the NET-MSC-GB EX1 card

5. Push down, gently at first, ensuring you have the pins aligned correctly with the slot, and then apply more
pressure to slot the card fully home.

6. Use the screw which was used to retain the backing plate to secure the card in place and check that the card
sits comfortably.

7. Finally, replace the case cover(s) and switch the machine back on at the socket.
8. Atthe next power up and boot Windows will discover the Merging Ethernet PCle card.
Pyramix v12.x can now be installed.

Required Software

In order to operate Pyramix with RAVENNA and Horus / Hapi, Pyramix must be installed. The Pyramix v12 installer
includes Apple bonjour. As of Pyramix v11.0.7 HotFix the installer no longer includes the ANEMAN application
which now comes as a separate installer. Please download and install the latest ANEMAN in order to manage and
monitor your AolP devices from:

www.aneman.net/#download

Note: Driver signing. Please tick Always trust “Merging Technologies” when the first
warning message about unsigned drivers appears.

Enter your Pyramix keys

Launch MTSecurity settings and enter your Pyramix v12 keys. Please see Entering your Key(s) on page 20.
Note: v12 keys are required and MassCore requires an RTX64 key in order to run RTX64
3.7.

Install MassCore
Please see: MassCore Installation on page 22

Note: A valid MassCore (Base) key and a valid MassCore 64-bit key are mandatory.

The MassCore key is held on the SafeNet dongle. Please make sure that you are in pos-
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session of a dongle and valid keys in order to operate Pyramix in MassCore-RAVENNA
mode.

Note: The NET-MSC-GBEX1 Ethernet card requires MassCore in order to function.

Configure RAVENNA in the VS3 Control Panel

Merging Technologies Virtual Studio Seﬂingl &J

/'“ Application | Pyramix Virtual Studio b |

Platform | MazsCore - |

Cores Allocation [zhared by all applications- requires admin rightz]

Windows 4 D 4 MazzCore [Dedicated]

Latency

@ Low latency [5.33ms (22 48, 95, 192, 384KHz)
AESET [4ms (3 48, 96, 192, 384KHz)
Eutra low latency [2.66ms (= 48, 96, 192, 384k Hz]

Iltra low lakency [1.33ms (2 48, 96, 192, 384kHz]

Hardware
On Bus Yideo/TC M onitor Jack

J—% [\ @

Ravenna

Audio Bridge
Digable Murnber of Channels [1/O]; | 16

@ ASI0 Device Mode [to create a wirtual ASID Device in the system)

Secondary Audio Device Host Mode
[to connect to an existing Audio Device in the system az a secondary [ /0]

Fiewire Mixer Mode [to create a Bewire Miser in the system]

| K | [ Apply ] | Cancel

VS3 Merging Technologies Virtual Studios Control Panel

1. Launch the VS3 Control Panel (Start: All Programs > Merging Technologies > VS3 Runtime > VS3 Control
Panel

Cores Allocation Leave on the default setting for now.

For now, leave Latency on the default setting Low Latency
Select Platform : MassCore

Select Hardware : On Bus as RAVENNA (box ticked)
Audio Bridge : Set as required.

Click on the OK button.

When the VS3 panel Do you want to save routing? dialog box appears, click on OK

V ® N o Uk w N

The VS3 control panel will close.
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Before First Launch

Before launching Pyramix v12, you must ensure that a PTP Master* is present on your RAVENNA network. Merg-
ing Technologies recommends using its Horus or Hapi converters as PTP Master.

* The Precision Time Protocol (PTP) is a protocol used to synchronize clocks throughout a computer network.

Note: RAVENNA mode supports all three Latency modes. (VS3 Control Panel )
To enable RAVENNA I/0O connections please refer to the separate RAVENNA Easy Connect
Guide.

Note: Merging Technologies highly recommend Low Latency or AES67 modes for opti-
mal performance. The Extra and Ultra latency modes should only be used on Merging
Turnkey systems or approved configurations since these modes can be very demanding
on performance, depending on system configuration and user workflow.

Note: Horus / Hapi users should refer to the Horus / Hapi User Manual for configuration
set-up with Pyramix.

Note: At the first Pyramix launch if your system is not configured correctly you might see
the message below:

Your system is not configured according to Merging’s recommendations.

Note: Some Windows updates could harm your system, we strongly advise you to Defer
Windows updates.
More details on the procedure to follow are available here:

https://confluence.merging.com/display/PUBLICDOC/Windows+10+Defer+Updates

Troubleshooting

RAVENNA: Horus / Hapi & Network configuration

Merging recommend that the Ethernet MassCore card and Horus / Hapi are configured to obtain an IP address
automatically.

Setting Horus / Hapi and Network Card to Obtain IP Addresses Automatically
Network Card

1. Open Network Connections in the Windows Control Panel

2. Right-click on the MassCore Ethernet card NET-MSC-GBEX1 and open Properties.

3. Select Internet Protocol Version 4, TPC/IPv4 (which is the only one activated) and click on Properties.
4. Select the Obtain an IP address automatically option.

5. Click on OKin each dialog to accept the changes and close the dialogs.

Horus / Hapi

1. Open the Horus / Hapi Setup >Advanced > Network page

2. Inthe IP address section select Auto

Setting Fixed IP addresses
Note: Setting a Fixed IP is not recommended due to the fact that the Horus / Hapi Main-
tenance mode will be only be effective in Auto IP mode. This is mandatory for Firmware
updates.

1. First, check the IP address of the Horus / Hapi device under Setup > Network

To be able to see each other, the Merging Technologies Network card and Horus / Hapi must be in the same
range of addresses. (for example 192.168.xxX.xx).
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2. The Horus/Hapi IP address can be checked (and changed if required in the Horus / Hapi Setup page> Net-
work)

3. TheIP address of the MT Network card can be changed in Windows Control Panel > Change Adapter Set-
tings

4. Right click on the Merging Technologies NIC and select Properties.
Select Internet Protocol Version 4, TPC/IPv4 (which is the only one activated) and click on Properties.

6. Switch to Use the following IP address and enter an IP address that is in the same range as the Horus / Hapi
IP address. The Subnet Mask should be added automatically.

7. Click on OK in each dialog to accept the changes and close the dialogs.

Windows Firewall and UAC
Recommendation

If not configured correctly, Windows Firewall can block communication between MassCore and Horus / Hapi. User
Account Control should also be set to Never Notify.

Firewall

. Open the Windows Control Panel. Open the System and Security section and under Windows Firewall
disable the Firewall for the Public Network.

. Go back to the Windows Control Panel and click on Windows Firewall. Click on Change notification
settings. Ensure Block all incoming connections, including those in the list of allowed programs is
NOT ticked.

User Account Control
. Open the Windows Control Panel. Open the User Accounts section and under Change User Account
Control Settings move the slider down to Never Notify.

Antivirus
Recommendation

. Merging also recommends that any Antivirus software is properly configured so as to not interfere with
the DAW. See this page for further details:

https://confluence.merging.com/display/PUBLICDOC/Antivirus+and+Merging+Technologies+Softwares
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11 Native - ASIO

Note: Windows 10 May Update (1903) is supported as of Pyramix Native v12.0.5 and
above only. Previous Pyramix versions will NOT run under the May Update (1903).

Install Pyramix and the drivers for your ASIO device.

Configure ASIO in the VS3 Control Panel

z Merging Technologies Virtual Studio Settings ‘ &J \
/1“ Application |F‘y'ramix Virtual Studio - |
Platform [ Native - ASIO -
[/0 Selection
Drriver name: |.-’-'-.SIEI Fireface LISE w7
Info

SampleFlate; 42000
[npLks: 14
Olutputs: 18
Buffer zize 256

Toprnozt priarity

Audio Bridge
{ Mumber of Channels (140 16

ASI0 Device Mode [to create a wvirtual ASI0 Device in the syztem]

Secondary Audio Device Host Mode
[to connect to an existing Audio Device in the system az a secondary | /0]

Rewire Miver Mode [to create a Bewire Miker in the spstemn)

[ QK ] [ Apply ] | Cancel

- -

VS3 Merging Technologies Virtual Studios Control Panel

1. Launch the VS3 Control Panel (Start: All Programs > Merging Technologies > VS3 Runtime > VS3 Control
Panel

Select Platform : Native - ASIO

Select 1/0 Selection ; Driver name : Select your ASIO device from the drop-down list
Audio Bridge : Set as required.

Click on the OK button.

When the VS3 panel Do you want to save routing? dialog box appears, click on OK

N oy s W N

The VS3 control panel will close.

The Inputs and Outputs present on the ASIO device will now be available in Pyramix.
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RAVENNA ASIO

If you wish to use the RAVENNA ASIO driver with one of Merging Technologies RAVENNA interfaces. Please see the
RAVENNA ASIO Guide here:

http://www.merging.com/uploads/assets/Installers/ravenna/ASIO/Merging%20Ravenna%20ASI0%20Guide.pdf

12 First launch

Important! After installation has been completed, please reboot the PC before
attempting to launch Pyramix Virtual Studio. Then open the VS3 control panel applica-
tion.

Start: All Programs > Merging Technologies > VS3 Runtime > VS3 control panel

For Systems with MassCore RAVENNA
Please see: Configure RAVENNA in the VS3 Control Panel on page 29

For Native Systems
Please see: Configure ASIO in the VS3 Control Panel on page 32

Launch Pyramix
Double-click on the Pyramix Virtual Studio desktop icon to launch Pyramix.

Please see important information on next page!

Note: At the first launch a firewall approval dialog may appear:

¥ Windows Secu rity Alert @

@ Windows Firewall has blocked some features of this program

Windows Firewall has blocked some features of Pyramix Virtual Studio Application on all public
and private networks,

@ Uame: N | .
Publisher: Merging Technologies 5. A.

Path: C:'program filesimerging technologies\pyramix virtual
studio\pyramix. exe

Allow Pyramix Virtual Studio Application to communicate on these networks:

| Private networks, such as my home or work netwark

Public networks, such as those in airports and coffee shops (not recommended
because these networks often have litte or no security)

What are the risks of allowing a program through a firewall?

Allow access | | Cancel

Windows Security Alert dialog -Windows Firewall

Click on_Allow access since this is necessary to ensure correct Audio Connections and VT2 (Virtual Transport 2)
functioning.

Note: For further information about options available in the VS3 Control Panel, please
see the Pyramix User Manual.
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Note: At first Pyramix launch and or after installing MassCore the following alert box
may appear. If it does please reboot the computer one more time:

8 MassCore RunTime is not properly configured; configuration updated. Please reboot the computer.
1 |

VS3 error alert box

Note: If after a computer restart this error message still appears, please follow the
instructions in our knowledge base:

https://confluence.merging.com/display/PUBLICDOC/MassCore+Runtime-+is+not+properly+configured+error+message
For further assistance please contact:

support@merging.com

Note: At the first Pyramix launch if your system is not configured correctly you might see
the message below:

Your system is not configured according to Merging’s recommendations.

Note: Some Windows updates could harm your system, we strongly advise you to Defer
Windows updates.

More details on the procedure to follow are available here:

https://confluence.merging.com/display/PUBLICDOC/Windows+10+Defer+Updates

Documentation

The Pyramix User Manual and Quick Start Guide are available from within the application and may
be accessed via the Help menu or by pressing F1, or online at:

http://www.merging.com/downloads
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13 Troubleshooting

Please visit regularly:
www.merging.com

for the latest Troubleshooting Guide and FAQ sections.

14 Lost or Stolen Merging Technologies Security Keys

(SafeNet USB Dongles)

The Merging USB Key carries all the value of your Merging software and the software licence authorization to use
it. Please ensure you do not lose the USB key as Merging Technologies cannot be held responsible if this is lost or
stolen.

If your USB key is lost or stolen then please make a claim on your insurance in the usual way just as you would for
any other item you own. Merging will be happy to confirm the details and value of the software licence and USB
key to your insurance company. If your USB key is lost or stolen and a different user should attempt to register for
this key, Merging will notify you and the authorities in your country that an attempt has been made to register this
stolen item.

If your USB key should become defective or is broken, please ensure this key is returned to Merging after request-
ing and RMA (Return Merchandise Authorization.) Only after the receipt of this key in the Merging Offices will it be
determined if it may be exchanged under warranty free-of-charge, or if the damage is outside the warranty scope.
in which case only a modest fee to replace it with a new key will be charged (and not the entire value of the soft-
ware.)
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15 Contacting Merging

International Office:
Merging Technologies S.A.
Le Verney 4
CH-1070 Puidoux
Switzerland
Phone: +41 21 946 0444

UK:
Merging UK (Emerging Ltd)
23 Campbell Court
Campbell Road
Bramley
Hampshire
RG26 5EG
UK
Phone: +44 (0) 118 402 5090
Fax: +44 (0) 870 123 1747

Email: sales@merginguk.com

USA:
Merging USA (Independent Audio)
43 Deerfield Road
Portland,
ME 04101-1805
United States of America
Phone: +1(207) 773 2424
Fax: +1(207) 773 2422

For all documentation inquiries or suggestions for improvement:
http://www.merging.com
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